
 

 

 

LiDAR Derived Data to Inform Vegetative Structural 

Conditions 

Agreement # 15-CS-11030700-018  

 
Prepared for the U.S. Forest Service by 

The Nature Conservancy 
 
 

 
 
 
 
 

Suggested Citation: 
 

Woolley, T. 2016. LiDAR Derived Data to Inform Vegetative Structural Conditions. Flagstaff, Arizona. 

 

For more information about this report please contact: 

Travis Woolley, Forest Ecologist 

The Nature Conservancy 

114 N. San Francisco Street, Suite 205 

Flagstaff, Arizona 86001 

(928) 774-0831 

twoolley@tnc.org 

 

 

mailto:twoolley@tnc.org


Table of Contents 
 

Introduction ............................................................................................................................................................................ 1 

 

Methods .................................................................................................................................................................................. 3 

 

Canopy Cover ...................................................................................................................................................................... 3 

Even-aged Large (Young) Tree Structure ............................................................................................................................ 4 

LiDAR Metrics and CHM .................................................................................................................................................. 5 

Individual Tree Segmentation using CHM ....................................................................................................................... 7 

Field Verification ................................................................................................................................................................. 8 

 

Discussion ................................................................................................................................................................................ 8 

 

Literature Cited ....................................................................................................................................................................... 9 

 

Deliverables and Outreach .................................................................................................................................................... 11 

 

 

 

 

 

 

 

 

 

 

 

 



1 
 

Introduction  
Restoration of dry forests in northern Arizona, and planning of restoration treatments has recently begun to approach 

landscape scales. This approach has gained traction because large and uncharacteristically severe wildfires are pushing 

forests farther from desired conditions and exemplifying the lack of resiliency across these forested landscapes. 

Ponderosa pine forests of the North Kaibab are generally denser and more continuous than compared to historical 

reference conditions (Kaibab National Forest Land and 

Resource Management Plan USDA 2014). Much of the 

restoration work to move landscapes towards desired 

conditions and re-establish fire regimes emphasizes 

mechanical thinning as a tool for reducing tree densities 

so natural and managed fire can be re-introduced into 

the system. When planning landscape scale (> 10,000 

acres) restoration projects, it can be challenging to obtain 

site-specific data on existing conditions over these larger 

areas. The ability of remotely sensed data sets such as 

LiDAR, and innovative approaches to applying that data, 

are key to assisting project planners and specialists with 

large landscape scale restoration projects. 

For this project, the Burnt Corral Planning and Analysis 

area on the North Kaibab Ranger District, Kaibab National 

Forest in northern Arizona (Figure 1) was used as a case 

study to develop and provide useful information 

regarding existing forest structure, particularly related to 

large tree and canopy cover components. The density and 

spatial arrangement of large trees influences potential 

fire behavior (particularly crown fire), enhances water 

interception, influences carbon sequestration and 

storage, and provides habitat characteristics for some 

wildlife species. Across the southwest, large tree 

occurrence is infrequent compared to historical 

conditions. Their retention across the landscape is of considerable importance given that the ecosystem services they 

provide are disproportionately high given their limited abundance on the forest. Prior to the initiation of this project, a 

collaborative planning process, led by the Landscape Conservation Initiative at Northern Arizona University, was 

undertaken to “develop a proposed action for vegetative treatment…using a collaborative approach supported by 

spatial analysis and group deliberation” (Sisk et al., 2014). One of the remaining issues not resolved by the stakeholder 

process was large tree retention and the use and effectiveness of a diameter cap to achieve project objectives. Whether 

or not consensus is reached, the identification of areas with a larger and older trees is key to developing alternatives for 

restoration, principally mechanical thinning prescriptions. 

Figure 1 – Burnt Corral Project Area within the LiDAR footprint collected 
within the North Kaibab Ranger District, Kaibab National Forest 
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In 2013, Region 3 of the USFS contracted to collect Light 

Detection and Ranging (LiDAR) data across of the North Kaibab 

Ranger District (Figure 1: WSI Technical Data Report 2012). The 

acquisition and subsequent data/products cover 457,925 acres of 

forest and woodland vegetation types. LiDAR is a remote sensing 

technology that uses a laser emitter-receiver scanning unit that 

sends 200,000 pulses of light per second to the ground (Figure 2: 

McGaughey 2014) while measuring the time for pulses to reflect 

off of the canopy and ground surfaces. This results in a 3-D model 

of ground surface, vegetation, roads, and buildings that is 

spatially explicit and provides highly accurate estimates of 

vegetation height, cover and canopy structure (Lefsky et al. 

2002). This data also lends itself to modeling to estimate forest 

parameters such as leaf area index (LAI), biomass, volume, and 

tree density. 

The overarching objective of the cost-share project between The 

Nature Conservancy (TNC) and the Kaibab National Forest (KNF) 

was to develop analytical methods to better integrate existing 

LiDAR data into project level planning and analysis leading to 

more informed management, improved transparency, and 

stakeholder consensus. Using the existing LiDAR dataset and 

spatial data developed by the Remote Sensing and Applications 

Center (RSAC), procedures (see Appendix A: Workflow) and 

resulting data layers can improve the identification of existing 

forest structural conditions. In particular, the USFS was interested 

in two sets of products for the Burnt Corral Project area 1) 

Canopy cover data layers 2) spatial data indicative of large young tree density existing in an even-aged canopy structure. 

This report elucidates the concepts and methods developed to produce these spatial data, and illustrates the resulting 

data. This information can provide the USFS with an improved 

ability to meet forest plan desired conditions, such as large 

trees (>18 inches in diameter) contributing the largest 

percentage of basal area in ponderosa pine vegetation types. 

These empirically defined and data driven methods can also 

help to inform stakeholder driven planning processes by 

improving transparency in decision making by the forest 

service. 

Figure 2 -  Kaibab LiDAR data acquisition area. Delivery 1 was a 
preliminary subset of products delivered and Delivery 2 included a 
complete ground point shapefile geodatabase. 

Figure 3- Schematic of an airborne laser scanning system. 
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Methods 
Canopy Cover 

Canopy cover is a metric often used to describe the 

canopy structure of the forest.  Defined in the USDA 

Forest Service Common Stand Exam Users Guide 

(2010) as “the percent of a fixed area covered by the 

crown of an individual plant species or delimited by 

the vertical projection of its outermost perimeter; 

small openings in the crown are included”. This differs 

from canopy closure in that canopy cover does not take 

into account light interception and other factors that 

influence microhabitat (Egan 2010). Canopy cover can 

be measured in various ways, from ground based 

measurements of canopy extent to using remotely 

sensed information such as aerial imagery or LiDAR.  

For this project we produced spatial canopy cover 

products for the Burnt Corral project area using a 

LiDAR derived 1-meter resolution Canopy Height 

Model (CHM -Figure 4). This differs from the RSAC 

produced spatial canopy cover layer (25-meter resolution), 

which uses the differencing between canopy returns of 

interest (chosen height threshold) and all returns (Equation 

1) to derive a raster of canopy cover values (Figure 5). 

 
Equation 1:               
 

 𝐶𝑜𝑣𝑒𝑟 = (
# of returns>Threshold

Total Returns
) ∗ 100 

 
This method of computing canopy cover may be more 
similar to an estimate of canopy closer (Egan 2010) than 
canopy cover. In contrast, using the CHM explicitly bases the 
estimates on a canopy projection. The CHM raster is a 2 
dimensional depiction of canopy area. Presumably each 
pixel with a height value greater than 3 meters is 
considered tree canopy. This threshold could be altered and 
applied to derive canopy cover for any canopy strata of 
interest (e.g., a single diameter class 5-12”, or all diameter 
classes > 18”).  
 

A threshold must be chosen that represents height values 

related to the canopy strata of interest. To apply this 

threshold, the 1-meter CHM is converted to a raster of 1’s and 

Figure 4 - 1-meter resolution Canopy Height Model (CHM) raster. 

 Figure 5 - 25-meter resolution Canopy cover raster derived directly from 
LiDAR returns (Equation 1) 
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0’s, 1’s being raster cells that are canopy height values > threshold, 0’s being height values < than threshold. The 

resulting raster is then scaled up by summing all 1-

meter raster cells in a 30 m x 30 m zone together 

(sum of 900 raster cells). This scale can be changed 

depending upon the scale desired. If a per hectare 

estimate is more appropriate/desired, then using 

100 m x 100m scale would be applied. Using the new 

30-meter raster we then divided each 30-meter 

raster cell value by 900 (the maximum possible 

value) and multiplied by 100 to obtain a percent 

canopy cover value for each 30-meter cell. Figure 6 

depicts this as a vector (polygon) layer following 

reclassification into quartile bins (0-25%, 25-50%, 

50-75%, 75-100%). 

 
For this project, three canopy cover layers were 
delivered: 
 
1. Canopy cover > 3 meters using RSAC/FUSION 

methods reclassified into quartiles and converted to 

vector. 

2. Canopy cover > 2 meters using CHM method 

for all canopy reclassified into quartiles and converted 

to vector. 

3. Canopy cover > 15 meters and < 23 meters 

using CHM method for all canopy reclassified in to 

quartiles and converted to vector. 
 
 
The third canopy cover product 
height thresholds were based on a 
diameter distribution of 12-18”, 
using 15” as the mean of that 
distribution, and assuming a 
height range for that distribution 
of 15-22 m.  
 

Even-aged Large (Young) Tree 

Structure 

One of the needs of silviculturists 

when planning restoration 

treatments, particularly mechanical 

thinning, is to identify/quantify on 

the landscape certain structural 

characteristics that inform the 

existing condition. Using this spatial 

data subsequent project design and 

prescriptions could be developed 

more precisely to make progress 

Figure 6 - 30-meter canopy cover layer derived from the Canopy Height 
Model. 

Figure 7 - LiDAR point cloud for a 20-meter cell illustrating skewness in the canopy height 
distribution. 
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toward a specific desired condition. In particular, there are areas of interest to both managers and stakeholders that can 

be defined as having a similar size/age structure (even-aged) while carrying a preponderance of larger trees. In general, 

LiDAR derived data, particularly the CHM, can be very useful in identifying larger (i.e., taller) trees across multiple scales. 

The CHM can be used in multiple ways to derive spatial data layers that indicate and/or quantify various tree canopy 

structure. We used two different approaches to identify density of larger (taller) trees and/or even aged canopy 

stratification: 1) RSAC delivered metrics derived from the LiDAR point cloud in combination with a 1-meter CHM, and 2) 

Individual tree segmentation using a 1-meter CHM.  

LiDAR Metrics and CHM 

To provide spatial data for the Burnt Corral project area that relates to older and larger (taller) trees existing in an 

even-aged condition we used a 1-meter CHM derived from the raw LiDAR data applying FUSION (McGaughey 2014) 

methods. To derive a CHM, FUSION subtracts the ground return values from the canopy return values for each 1-

meter cell, producing a raster (Figure 4) of canopy height that can then be used to spatially assess where canopy 

structure relates to height. The workflow developed to create this data was based on several assumptions. First, 

regarding large trees, we used height as a surrogate for larger tree size often referred to by diameter. LiDAR provides 

extremely precise estimates of tree height, and there are defined relationships between tree height or canopy area 

(Sanchez-Meador et. al., 2011) and tree size (i.e., diameter). Secondly, we assumed that an even-aged forest structure 

can be defined as having a lack of vertical stratification in the canopy, whereas an uneven-aged forest structure 

would have some degree of vertical stratification or heterogeneity. Two proxies for vertical canopy stratification 

based on the LiDAR data were examined, 1) the standard deviation of height and 2) the skewness of height (Figure 

7). For standard deviation of height, we assumed that a larger standard deviation of height values in the LiDAR 

canopy return data would represent more vertical stratification/heterogeneity and be indicative of more un-even 

aged structure. Smaller standard deviation of height values would reflect the opposite and be indicative of even-aged 

forest structure. Similarly, for skewness of height we assumed that values of skewness that were larger indicated 

that the canopy was skewed to upper canopy while smaller values reflect canopy height was skewed to shorter 

Figure 8 - Screenshot illustrating the use of classification breaks in ArcGIS to determine quartile breaks for height distribution of the 
CHM. 
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canopy structure. For all subsequent analysis and reporting 

we chose to focus on the standard deviation of height because 

it is a more intuitive variable to communicate to managers 

and others.  

Using the distribution of height values in the CHM (Figure 8), 

a reclassification based on quartiles was performed. This 

step allows an additional reclassification based on values of 

height for the question of interest. For example, Woolley 

(2014) showed that in areas tested on the North Kaibab 

Ranger District the 75th percentile and greater was an 

adequate threshold to capture old-growth trees (field based 

determination classified by a set of characteristics indicative 

of tree age). In this project the 50th-75th percentile was used 

as it likely represents larger/younger trees that are not yet 

exhibiting old-growth characteristics, and are a component 

of the forest structure that managers and stakeholders feel is 

prime for promoting larger/older forest habitat structure.  

Similarly, we classified 5 quantiles based on the distribution 

of standard deviation of height values. The first four 

categories represent the majority of the distribution, while 

the fifth category represented extreme outliers (cliff 

artifacts, birds, etc.). Using the 50-75th percentile CHM data 

in combination with the categorized standard deviation data, 

we created a combination data layer by multiplying these 

two raster datasets together. The resulting dataset (Figure 

9) categorizes the project area into six categories (0-5). 

Values of 0 represent areas where the tall/young trees do 

not exist (either too small or too large). Values of 1 or 2 are 

areas of potentially larger (i.e., taller) trees with very little 

deviation of height in canopy (0-3.5 meters standard 

deviation). This condition would be considered more of an 

even-aged forest structure containing larger trees. Values 

of 3 and 4 represent areas where larger trees exist with 

larger deviation in canopy height, potentially representing 

more of an uneven-aged forest structure condition. This 

raster was then converted to a point layer in order to run 

the kernel density tool in ArcGIS (ESRI 2014). This tool 

calculates a magnitude per-unit-area from point/polyline 

features using a kernel function to fit a smoothly tapered 

surface. This results in a raster layer with a “density” 

estimate (Figure 10). The layers developed by this specific 

analysis, and used in the kernel density analysis, don’t 

represent individual trees, the default area was used as an 

example to visually represent how overall “density” of 

larger trees can be identified on the landscape. 

Figure 9 - Raster dataset derived by multiplying the 50th-75th 
percentile CHM values by the Standard deviation in height values. 

Figure 10 - Raster dataset derived using Kernel Density analysis to 
illustrate the relative density of even-aged larger trees. 
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Individual Tree Segmentation using CHM 

A more detailed and quantifiable (i.e., tree/hectare) method 

for determining the density of large trees for landscape 

restoration planning and prescription development 

involves using the canopy height model to identify 

individual tree crowns using the CHM.  There are many 

methods to accomplish this task, in this project we chose to 

use methodology from FUSION to identify individual trees. 

All of the processes described here are available as 

packages in the statistical package R (R Core Team 2013). 

First, a smoothing function was applied to the existing CHM 

produced by RSAC (or a CHM derived using FUSION 

functions). Following smoothing, a local maximum function 

with a moving window applied to identify the location and 

height of each individual tree. The moving window 

basically takes a set of cells and identifies the highest point 

within those cells and determines that it is an individual 

tree. The moving window size is set to be similar to canopy 

areas for a given tree/forest type. The final step is to 

identify and segregate the area of individual canopies for 

each identified tree. This method results in a dataset with 

locations, heights, and canopy area/radii for each 

individual tree identified from the CHM. A crown area and 

diameter relationship (Sanchez-Meador et. al., 2011) was applied to the data to derive diameter at breast height for 

each tree. Diameter can be derived in other ways, for example, if local data exists that relates diameter to height, 

the height values for each tree can be used to predict diameter. Similar to the even-aged raster analysis, a kernel 

density analysis was applied to the individual tree location dataset to quantify the density of larger trees (Figure 

11). However, with the individual tree location data we were able to choose the scale at which we applied the 

kernel density tool. Given trees per acre as a commonly used estimate, the kernel density tool was applied to trees 

>16” at an acre scale, resulting in estimates of trees >16”/acre. We chose the 16” threshold as this is a common 

socially derived cut-off for large ponderosa pine trees in the region.  

The resulting datasets; individual tree locations, height, crown area, diameter at breast height; and rasters 

produced from this layer can be extremely useful in quantifying existing condition. Individual tree list data 

provides spatially explicit inventory data that can be summarized to the desired scale (i.e., stand, restoration unit, 

watershed etc.) for forest structural parameters such as tree density and basal area.  One main benefit of LiDAR 

data is that it provides information on every square meter of ground for which it is collected. As with all datasets 

there are sources of error, however, having some uncertainty everywhere on the landscape can at least be 

supplemental to datasets (e.g., stand exams) where a large degree of uncertainty exists in areas of the landscape 

that have not been sampled. 

 

 

Figure 11 - Large tree density (>16" dbh) derived from individual 
tree segmentation using Kernel Density analysis. 
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Field Verification 

Although LiDAR data does represent forest structure (e.g, height, canopy cover) across every square meter of the 

project area, the methods and products developed for this report, particularly those using the CHM and other 

metrics related to height, have not been field validated. Initial accuracy assessment for individual tree 

segmentation has shown confidence in predicting larger trees (e.g., > 10” in diameter), but that sub-canopy trees 

are difficult to detect with a high level of accuracy. Interestingly, the two layers relating to the density of larger 

trees (CHM and standard deviation derived vs. individual tree segmentation) resulted in similar patterns of areas 

predicted to have larger trees in higher densities. This can be seen by comparing Figures 10 and 11. To begin field 

validation for  areas of higher large tree density, a few field sites have been visited to visually assess the general 

stand structure relative to the two LiDAR derived products. Figure 12 illustrates the current condition in areas 

visited relative to the LiDAR derived products (Figures 10 and 11) and generally supports the potential of these 

products to provide valuable information to the planning process. As with any data product, particularly spatial 

products, it is valuable to make field visits to verify and further refine understanding of existing conditions as this 

will help to validate restoration treatments that move toward desired future conditions. Further assessment of 

these data products is ongoing and USFS staff will be apprised of results of this work in the future. 

 

 
Figure 12 - Field photos illustrating sites predicted to have a high density of large trees (top photos) and sites that were not predicted to have 
high density (bottom two photos). 

Discussion 
The impetus for this project was to provide additional spatial information that would inform project level analyses for 

large scale restoration projects, using the Burnt Corral Project as a pilot. One of the more contentious topics in 

collaborative discussions of restoration projects involving mechanical thinning is that of larger diameter trees, 

particularly those that do not meet old-growth criteria (Van Pelt 2008) but do provide unique wildlife habitat 

characteristics and maintain forest structural attributes that may be lacking on the landscape. To move forward with 
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selective thinning treatments collaborative stakeholder groups must find implementation strategies in which these areas 

are protected from large uncharacteristically severe wildfires, continue to provide the large tree structural components 

for wildlife habitat, and produce increased ecological integrity and resilience across the landscape. The first step in this 

process, to help build trust and more refined treatment options, is to have the best available data and science to base 

those collaborative decisions on. The quantity and location of areas of special interest can be key to addressing the 

concerns of stakeholders while giving managers the flexibility to meet multiple objectives across the landscape. 

LiDAR data, applications, and products can help to provide the basis for further collaborative refinement of treatment 

alternatives, particularly as the cost of the data becomes less prohibitive and the value of the products resulting from 

this data collection are shown (Hummel et al., 2011). In addition, LiDAR data can readily be used for monitoring at 

multiple scales (individual tree to stands to landscapes), making it extremely relevant under new planning rules that 

require broad scale monitoring approaches across forests/regions (National Forest System Land Management Planning 

2012). Increased training on potential applications and fundamentals of LiDAR data processing will afford novel 

approaches to restoration planning by natural resource specialists. The additional information provided by LIDAR can 

help to achieve the overall goal of moving forward with collaborative decisions based on the best available data and 

science. 
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Deliverables and Outreach  
The following deliverables have been provided by TNC to the Kaibab NF based on the Supplemental Project 
Agreement # 15-CS-11030700-018: 
 

 To inform project level analysis on the Burnt Corral Project area: 

1. Canopy Cover layers derived from 1-meter LiDAR Canopy Height Model (CHM) raster. 

2. Raster layer illustrating areas of higher large (tall) tree density with even-aged structural 

characteristics 

3. Point layer of all individual trees detected using LiDAR 1-meter CHM. 

4. Raster layer illustrating areas of higher large tree density based on individual tree detections 

 Technology Transfer presentation and tutorial for Silviculture, Wildlife, and GIS specialist staff on the 

Kaibab NF (July 12th, 2016 12pm-4pm). 

 Workflow document (Appendix A) outlining data use and processing steps for GIS layer deliverables 

 Technology transfer handout and PowerPoint presentation (Delivered with Final Report). 

 Final Report outlining project outcomes and deliverables. 

Appendices 

The following workflow and technology transfer handout outline has been developed based on the 

development of deliverables for this project. It is followed by a technology transfer handout that provides 

examples and screenshots to provide an outline for those with less Geographic Information Systems (GIS) 

experience to follow and produce usable outputs. Familiarity with using ArcGIS raster processing tools is the 

minimum experience level needed to work through the methods outlined, however assistance from GIS 

specialists may be needed. 

Appendix A: Work Flow (see Appendix B for screen shots) 

1. Canopy cover layers  

a. Overall canopy cover in quartiles 

i. Canopy Height Model Method 

ii. LiDAR Point Cloud Derived Canopy Cover Raster 

b. Upper Canopy Cover – uneven-aged stands - > 55-70’ (17 – 22 meters) 

c. Layers to use (all layer files have _BC added to the end since I clipped LiDAR rasters to Burnt Corral (BC) 

project area). 

i. Canopy Height Model (CHM) ‘nk_ch_mosaic_8b_BC.tif’ 

ii. 25 meter Canopy Cover (CC) ‘full_all_cover_above3_25METERS_BC.tif’ 

 

d. Procedures 1 a.i. 

i. Reclassify CHM raster as canopy or open (1,0) (reclassify tool) 

ii. Sum cells in 30x30 meter area (0-900) (Aggregate tool 30)  

iii. Run Float tool to convert from integer (Spatial Analyst Toolbox)  

iv. (Divide Tool: Cell value divided by 900 to get % Cover value) 

v. Reclassify cells into 0-25, 25-50, 50-75, 75-100%  

1. Classification 
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a. 1 = 0-25% canopy 

b. 2= 25-50% 

c. 3= 50-75% 

d. 4= 75-100% 

vi. Apply Majority filter (8 Neighbors, Half replacement threshold) 

vii. Convert to Polygon (Do not Simplify) 

viii. Apply simplify or smooth polygon tools if desired (not done for this analysis) 

 

e. Procedures 1 a.ii. 

 

i. Reclassify RSAC ‘full_all_cover_above3_25METERS_BC.tif’ raster 0-25, 25-50, 50-75, 75-100%  

1. Classification 

a. 1 = 0-25% canopy 

b. 2= 25-50% 

c. 3= 50-75% 

d. 4= 75-100% 

ii. Apply Majority filter (8 Neighbors, Half replacement threshold) 

iii. Convert to Polygon (Do not Simplify) 

iv. Apply simplify or smooth polygon tools if desired (not done for this analysis) 

 

 

 

f. Procedures 1 b. 

i. Reclassify CHM so that heights above 15 meters are classified as 1 and remaining values below 

15 meters are 0’s. 

ii. Sum cells in 30x30 meter area (0-900) (Aggregate tool 30) 

iii. Run Float tool to convert from integer (Spatial Analyst Toolbox)  

iv. (Divide Tool: Cell value divided by 900 to get % Cover value) 

v. Reclassify cells into 0-25, 25-50, 50-75, 75-100%  

1. Classification 

a. 1 = 0-25% canopy 

b. 2= 25-50% 

c. 3= 50-75% 

d. 4= 75-100% 

vi. Apply Majority filter (8 Neighbors, Half replacement threshold) 

vii. Convert to Polygon (Do not Simplify) 

viii. Apply simplify or smooth polygon tools if desired (not done for this analysis) 

 

 

g. Deliverables PRODUCED 

i. Canopy Cover  (from RSAC) converted to canopy cover classes 

1. Filename - ‘full_all_cover_above3_25meters_bc_poly’ 

ii. Canopy Cover (using CHM) converted to canopy  cover classes 
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1. Filename - ‘chm_cover_above2_30meters_bc_poly’ 

iii. Canopy cover of upper canopy trees (15-23 meters) using CHM)  only converted to canopy cover 

classes 

1. Filename – ‘chm_cover_above15_30mres_bc_poly’ 

 

2. Layer of Even aged larger preponderance of large young trees (PLYT) 

a. Assumptions 

i. Larger = Taller 

ii. Even aged = Similar height across canopy 

b. Layers to use (all layer files have _BC added to the end since I clipped LiDAR rasters to Burnt Corral (BC) 

project area).  

i. Canopy Height Model (CHM). ‘nk_ch_mosaic_8b_BC.tif’ 

ii. Standard Deviation of point cloud height (SDH). ‘full_elev_stddev_2plus_25METERS_BC.tif’  

Skewness raster could be valuable as well to determine whether canopy heights are skewed 

towards taller trees (even aged) or evenly distributed throughout the canopy (uneven-aged) 

c. Procedures 

i. Reclassify CHM in to broader categories.  

1. Use distribution of reasonable height values (ignoring 0’s and excluding extremely high 

values for cliffs) divide distribution into percentiles (0-25, 25-50, 50-75, 75-100%). For 

this analysis the following quartile cutoffs were used based on the canopy height 

distribution: 

a. 0-25% = 0 - 12.5  meters 

b. 25-50% = 12.5 – 25 meters  

c. 50-75% = 25 – 37.5 meters 

d. 75-100% = 37.5 – 50 meters 

2. Categories – If tall trees are the target, decide what height values represent taller trees. 

a.  For old growth, > 75th percentile is adequate (see Woolley 2014 report to KNF). 

b. For large/tall trees that may still be young a different value should be used. For 

this analysis I chose 50th-75th percentile height range to reduce the data to 

PLYT. 

ii. Reclassify CHM with 50-75 percentile value of height – Create category of 0 and 1 (1 being 50-

75th percentile values, and 0 everything else). 

iii. Resample SDH (25 m resolution) to 1 meter resolution to match CHM raster.  

iv. Reclassify SDH into 4 categories based on quantiles from 0-14 meters (0-3.5, 3.5-7, 7-10.5, 10.5-

14) and a fifth category for outliers of 14+ meters. 

v. Multiply Reclassified CHM (‘nk_ch_mosaic_8b_BC_reclass_50-75thpercentile.tif’) by 

reclassified SDH.  

1. Resulting layer is classified from 0-5. 0’s represent areas where tall/large trees aren’t 

detected based on CHM percentile classification. 1-5s’ represents areas with tall trees 

with varying ranges in overall canopy. 

a. 1’s and 2’s = Tall trees with very little deviation in the height of canopy 

(particularly 1’s) and are more likely to be even aged taller trees. 

b. 3’s and 4’s = Tall trees with much larger deviations in in the height of canopy 

and likely have more stratification of canopy layers and may have more uneven 

aged structural characteristics (i.e., multi-layered/aged canopy trees) 
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c. 5’s = Likely outliers of high standard deviation based on cliff artifacts, birds, etc. 

 

d. Deliverables PRODUCED 

i. Raster layer denoting areas where larger (taller) trees exist with varying stratification of the 

canopy (even-aged and uneven aged). 

1. ‘CHM_SDH_multiply_BC.tif’ 

ii. Kernel Density Raster 

1. Convert ‘CHM_SDH_multiply_BC.tif’ to point shapefile (Raster to point Conversion tool) 

2. Clip point shapefile file to only include 1’s and 2’s (see C.V.1. above) 

3. Run Kernel density tool (default settings used) on subsequent shapefile to produce 

raster that indicates where the highest density of “even-aged” tall tree areas exist. 

4. Resulting density raster of potential ‘even aged large tree’ structure ‘KernelD_Even 

aged_LargeTree.tif’  

 

 

 

 

3. Individual Tree Segmentation tree list 

a.  Using Canopy Height Model (CHM) Raster this process applies several steps to identify individual tree 

crowns, their local maximum (top of tree), and determines crown area. The analysis was performed 

using R software and the package rLiDAR (https://cran.r-project.org/web/packages/rLiDAR/rLiDAR.pdf).  

i. Methods (see manual for specific functions) 

1. Derive a CHM from LIDAR .las data (or use RSAC developed CHM) and run smoothing 

function. 

2. Identifies the location and height of individual trees using a local maximum function 

with a fixed moving window. This identifies the highest point within a set of pixels and 

determines the highest point is the top of an individual tree.  

3. Derives ground-projected canopy area of each individual tree using the CHM. 

4. Using published equation (Sanchez-Meador et al. 2011) predict diameter from crown 

radius value for each individual tree 

ii. Output data set(s) 

1. Point Shape file of individual tree records (rLiDAR_CHMSeg) 

a. X,Y,Z coordinates for tree location and height (Z) 

b. Ca (canopy area in square meters) 

c. Crad (Crown radius in meters) 

d. DBH_cm_pre (predicted diameter in centimeters) 

e. DBH_in_pre (predicted diameter in inches) 

f. Predicted diameter is derived from a regression equation relating crown radius 

and diameter (Sanchez-Meador et al. 2011).  

2. Kernel Density raster 

a. Large (tall with large canopy) 

iii. Uses/products 

1. This dataset can be summarized at any scale desired. Stand or compartment boundary 

layers can be used to summarize to the stand level, or 1-acre grid cells can be created to 

use for summary at a smaller scale. 

https://cran.r-project.org/web/packages/rLiDAR/rLiDAR.pdf
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2. Kernel Density maps as described above can also be created to quickly summarize and 

visualize areas with higher densities of larger trees. 

iv. Limitations 

1. Recent work by NAU (funded by TNC) has shown that Individual Tree Segmentation does 

not predict individual small (<8-10” DBH) trees accurately. This layer should be used as a 

larger scale planning tool to determine relative tree density of trees > 8-10” diameter.  

Appendix B: Technology Transfer Handout/Tutorial 

 

Exercise #1 – Using a LiDAR derived Canopy Height Model (CHM) to create a   
 Canopy Cover Raster layer 

 

Procedures 

1. Reclassify CHM Raster as either Canopy (1) or no canopy (0) 

a. Use Reclassify tool: Spatial Analyst Tools>Reclass>Reclassify 

b. Choose height threshold for canopy layers of interest 

i. Example: Canopy cover of “upper canopy”  

1. 12”-18” dbh - using an average of 15” a height threshold might be 55’-70’ (15-22 

meters) in height. 

ii. < 55’ height or >70’ height = 0 

iii. >55’ and <70’ = 1 
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c. Result: CHM Raster reclassified of only desired canopy height (i.e., 55-70’) 

 

2. Sum cells within 30x30 m area (900m2)  

a. Use Aggregate tool: Spatial Analyst > Generalization > Aggregate 

i. Cell Factor of 30 (makes it a 30 meter resolution raster output) 

 

a. Result: 30-meter resolution aggregation of 1’s and 0’s  

ii. Largest possible value is 900 (all canopy) and lowest is 0 (no canopy) 

 

3. Convert raster to integer  

a. Use Float Tool: Spatial Analyst > Math > Float 
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4. Divide cells by 900 to obtain % canopy cover values for each 30-meter cell 

a. Use Divide tool:  Spatial Analyst > Math > Divide 
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5. Result: Percent Canopy cover raster for canopy > 17 m and < 22 m in height (i.e., “upper canopy”)

 
6. Optional 

a. Reclassify to percentile classes of interest (e.g., 0-25, 25-50, 50-75, 75-100%) 

b. Convert to vector (polygon) 

Exercise #2 – Using LiDAR derived CHM to identify areas of younger and larger (taller) trees  
existing in an even-aged structure 

 

Procedures 

1. Reclassify/examine CHM into broader height categories based on quartiles 

a. Use Reclassify tool: Spatial Analyst Tools>Reclass>Reclassify 

i. 0-25% = 0 - 12.5  meters 

ii. 25-50% = 12.5 – 25 meters  

iii. 50-75% = 25 – 37.5 meters 

iv. 75-100% = 37.5 – 50 meters 

b. Use histogram to determine percentile height values and skip to Step C. 



19 
 

 

c. Height Values that represent young AND large 

i. Example 50th-75th percentile (25 - 37.5 meters) 

d. Reclassify/CHM into 2 categories 

i. 1 = 25-37.5 meters 

ii. 0=<25 meters or > 37.5 meters 

 

 

2. Resample Standard Deviation of Height (SDH) raster to same resolution as CHM (1 meter) 

a. Use Resample tool: Data Management > Raster > Raster processing 

i. *Use CHM raster as output cell size* 
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3. Reclassify SDH into 5 categories based on distribution and outliers 

a. 1 - 0-3.5 meters 

b. 2 - 3.5-7 meters 

c. 3 - 7-10.5 meters 

d. 4 - 10.5-14 meters 

e. 5 - > 14.0 meters (outliers) 

 

4. Multiply Reclassified CHM and Reclassified SDH 

 

5. Use Times tool:  Spatial Analyst > Math > Times 

 

6. Result: Raster layer of: 

c. 0’s = young large trees are not present 

d. 1’s and 2’s = Tall trees with very little deviation in the height of canopy (particularly 1’s) and are more 

likely to be even aged taller trees. 

e. 3’s and 4’s = Tall trees with much larger deviations in in the height of canopy and likely have more 

stratification of canopy layers and may have more uneven aged structural characteristics (i.e., multi-

layered/aged canopy trees) 

f. 5’s = Likely outliers of high standard deviation based on cliff artifacts, birds, etc. 

 

7. To Visually assess this more easily: 

a. Convert Raster cells of interest (for even-aged large young trees use values of 1 and 2) to points 

i. Use Raster to Point tool: Conversion Tools > From Raster > Raster to Point 
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b. Use Kernel Density Tool to identify areas with a “higher density” of young, large, uneven aged structure. 

i. Use Kernel Density Tool: Spatial Analyst Tools > Density > Kernel Density 

1. Choose units and cell size for desired output 

 

 

 

 

 

 

 

 

 

 


